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1. Getting Started
This section lets you get acquainted with various sections covered in this user manual which further
helps you in understanding the product, eViewer HTML5 .NET in a better way. You can also
understand the purpose of developing such product. This user guide also contains key features with
the system requirements for proper installation and use of product.
1.1 Brief about User Guide
Welcome to the user guide of eViewer HTML5 .NET which is proficient, competent and resultoriented product. This user guide has been designed for users to understand the software in an
efficient and effective manner. So we recommend you to carefully go through the user guide before
launching the product and keep it in a safe and easy accessible place for future reference.
1.2 Overview
eViewer HTML5 is a very powerful, yet hassle-free, Zero Footprint viewer for viewing multiple
formats including TIFF, JPG, PDF, MO:DCA and many others. It is a high-performance document
viewing solution that enables users to view documents and images from a desktop or any mobile
device within an internet browser. It uses HTML5, CSS, and JSP/Servlet to give your organization
the peace of mind that the documents are safe, yet provide a portable and dynamic viewing solution.
1.3 Features
eViewer HTML5 is loaded with rich features that make it complete and outstanding. Some of the
features are listed below:









Documents and images are directly retrieved and viewed through browsers.
Hassle-Free Integration: No workstation installation or platform compatibility issues due
to the use of Java, AJAX, and HTML5 technologies.
File Support: Supports most of the file formats as supported by our flagship viewer, MST
Viewer.
Annotation support: Including PDF and MO:DCA annotations.
File Conversion: Automatically converts files temporarily into an image format to display in
an internet browser. Also, provides an option to save the converted file to PDF, TIFF,
JPEG, GIF, BMP, or back to the original format.
Image Processing: Performed on the server to deliver an extremely high-speed response.
Easy Navigation: Go directly to any page on the document.
Printing: Print single and multi-page documents with or without annotations.
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1.4 Benefits
eViewer HTML5 provides a number of benefits including:





Reduce Overhead and Increase Productivity: Allows companies to reduce a number of

applications to one efficient universal document and image viewer.
Zero Footprint HTML5 Viewer: Compatible with up-to-date internet browsers with zero
client-side installation needed.
Annotations: Access to a number of different annotations including, but not limited to
redaction, line, arrow, rectangle, circle, text, highlighter, pen, and stamps.
Internal Development: All file formats are developed by in-house MST developers and do
not use any third party APIs. This gives you the ability to have customization, prompt
resolutions to issues, and release control.

1.5 Supported File Formats
eViewer HTML5 supports following file formats:
IBM proprietary file formats




MO:DCA (Mixed Object: Document Content Architecture)
IOCA (Image Object Content Architecture)
PTK (PTOCA)

Office file formats








DOC (Microsoft Word Document)
DOCX (Microsoft Word Document 2007 or later)
XLS (Microsoft Excel Spreadsheet)
XLSX (Microsoft Excel Spreadsheet 2007 or later)
PPT (PowerPoint Presentation)
PPTX (PowerPoint Presentation 2007 or later)
VSD (Microsoft Visio)

Documents




PDF (Adobe Portable Document)
RTF (Rich Text)
TXT (ASCII Text)
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CAD File Format




DWG (Autodesk Drawing)
DWF (Autodesk Vector)
DXF( Drawing Interchange)

Image file formats



























ABIC
BMP (Windows and OS/2 Bitmap Formats)
CAL (CALS Raster)
DCX (Paint Brush)
DCM (DICOM)
EMF (Windows Metafile)
GIF(CompuServe GIF)
JBG (JBIG)
JB2 (JBIG2)
JPG(Joint Photographic Experts Group (JPEG))
JPEG-XR (Windows Media Photo / HD Photo (HDP))
JPEG-LS (JPEG Lossless)
J2K (JPEG 2000)
JP2 (JPEG 2000 Compressed)
JPM (JPEG 2000 Part 6)
JPX (JPEG 2000 Part 2)
PNG (Portable Network Graphics)
PNM (Portable Bitmap Utilities)
PPM (Portable Pixel Map)
PBM (Portable Bitmap Utilities)
PCX (Paint Brush)
RAS (SUN Raster)
TIFF (Tagged Image File)
WBMP (Wireless Bitmap)
WMF (Windows Metafile)
XPM (XPicMap)
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2. Understanding User Interface (UI)
eViewer HTML5 .NET has a very user friendly and intuitive user interface that provide quick access
to all important functions the user needs.

Tabs

Thumbnail Window

Ribbon

Groups

Document View Area

2.1 The Ribbon
Ribbon combines the menu bar and toolbar into a single floating pane. The purpose of the ribbon is
to bring the most popular commands to the forefront, so you don‟t have to search for the most
common commands in the viewer.
Additionally, the ribbon includes several tabs that are used to reveal different groups of commands.
Since the ribbon contains both the program's menu options and toolbar commands, it cannot be
removed from the screen.
The Ribbon offers ease of use and convenience, with all common actions shown at one place. The
Ribbon has three parts – tabs, groups, and commands.
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Tabs
The Ribbon has four basic tabs across the top with each tab representing an activity area with their
own specified commands.

By default, the Home tab is displayed when the viewer is opened.

Groups
Commands are sectioned into groups within each tab.

Commands
A Command is a button or a box or a menu where you enter information. Commands are organized
in logical groups that are collected together under tabs.

For example, in the above group Zoom, (
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2.2 Toolbars and Tabs
eViewer HTML5 has five main toolbar that allows modifying any type of file. This main toolbar,
that is, File Tab, has options - Save, Save As, Export, Print, Comments, and Scan Document.
Home Tab
This is the standard view tab that is comprised of the following groups: Page Navigation, Zooming,
Rotation, Clipboard, and editing.

Commands

Command Decription
Zoom In: Increase the magnification percentage of the
page
Zoom Out: Decrease the magnification percentage of the
page
Rubber Band Zoom: Magnify specific area of the page
Rotate Counterclockwise: Rotate the page in an
anti-clockwise direction
Rotate Clockwise: Rotate the page in a clockwise direction
Cut: Cut the selected text or image or annotation from the
page
Copy: Copy the selected text or image or annotation from
the page
Paste: Insert the copied text or image or annotation at the
insertion point (cursor)

View Tab
This tab allows to change the view of the document that is comprised of the following groups:
image scaling, image processing functions, window modification, and other viewing tools.
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Commands

Command Decription
Fit to Window: Resize the document to fit entirely in the
window
Fit to Width: Resize the document to fit in the width of
the window
Fit to Height: Resize the document to fit in the height of
the window
Invert: Invert the color of the page
Flip Page: Flip page either horizontally or vertically
Gray Scale: Range of shades of gray without apparent
color
Enhance: Enhances the page of a document
Compare Doc: Comparing two documents in the viewer
Thumbnails: Display thumbnail view of the document

Annotation Tab
This tab contains the annotation tools available with the viewer with additional features - adding
bookmarks and watermark.

Command

Command Description
Color: Applies border color on the annotation
Line: Draw horizontal and vertical lines at 45°
Rectangle: Draws a rectangle
Circle: Draws a circle
Arrow: Draw horizontal, vertical or 45° arrows
Pen: Draws freehand lines and shapes
Highlighter: Highlight text on the document
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Text: Enter text on the page
Stamp: Place images or text stamp anywhere on the
document
Show/Hide Annotation: Show or hide annotations
made on the page
Add Watermark: Add watermark on the page
Add Bookmark: Add bookmark on the page
Delete Annotation: Delete annotations drawn on the
page

3. Common Tasks
This section lists the operations that can be performed by the eViewer document viewer.
3.1 Opening Documents
Documents can be opened in eViewer from the following ECMs:






From Microsoft SharePoint
From IBM FileNet P8
From IBM Content Manager 8
From EMC Documentum WebTop
From another CMIS ECM system

Opening Documents from Microsoft SharePoint
Perform the following steps to open a document from the SharePoint repository:
1.
2.
3.
4.

Open an Internet browser and enter in the SharePoint URL.
The login page appears.
Provide the user name and password.
After successfully logging in, the SharePoint Libraries and Lists will be displayed on the left
side of the screen.
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5. Click on the library from the list of libraries, displayed in the Libraries group.
6. The list of folders and documents exist in the selected library are populated on the right side
of the screen.

7. Perform one of the following:
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 For documents listed in library: Hover the mouse over the document that you want to
view in the eViewer. A checkbox will appear at the beginning corresponding to the
document. Select the checkbox and click eViewer HTML5 icon displayed on the ribbon.
The selected document will be opened in the viewer in a separate window.
 For folders listed in library: Double click on the folder. The list of document exist in the
folder were populated on the screen. Hover mouse over the document that you want to view
in the viewer. A checkbox will appear at the beginning corresponding to the document
Select the checkbox and click eViewer HTML5 icon displayed on the ribbon. The selected
document will be opened in the viewer in a separate window.
Opening Documents from FileNet P8
Perform the following steps to open a document from FileNet P8 repository:
1.
2.
3.
4.
5.
6.
7.
8.
9.

Open the browser and enter the FileNet P8 URL.
The login page appears.
Provide the user name and password.
The FileNet object stores page appears.
Select the object stores from the existing list.
The list of folders exists in the object stores were populated on the screen.
Click on the folder whose documents that you want to view in the viewer.
The list of documents exist in the selected folder were displayed on the screen.
Right click on the document that you want to view in the viewer and select Open in MST
viewer.
10. The selected document will be opened in the viewer in a separate window.
Opening Documents from IBM Content Manager 8
Please contact us to assist you with the integration with Content Manager 8.
Opening Documents from EMC Documentum WebTop
Please contact us to assist you with the integration with EMC‟s Documentum for WebTop.
Opening Documents from another CMIS ECM System
Please review the developer‟s guide on the available exposed APIs for connecting to other
applications.
3.2

Saving Documents

To save the document at its default location, click Save from the File tab.
To save the document at different location, click Save As from the File tab. The document gets
downloaded in its native format at the default download location.
User Manual
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3.3

Exporting Documents

To export the document, click Export from the File tab. The document gets exported to PDF at
the default download location.
3.4

Printing Documents

The document can be printed by performing the following steps:
1. From the File tab, click Print.
2. The Print Document dialog box will appear.

3. Provide the range of page numbers to print in From Page and To Page respectively.
4. Select or clear Print Annotation checkbox to print or not to print annotations made on the
page.
5. Select or clear Print Strike Out checkbox to allow strikeout comments to be print or not to
print on the page.
6. Select or clear Print Highlight checkbox to allow highlighted text to be print or not to print
on the page.
7. Click OK.
8. The Print dialog box appears.
9. Under Printer group, select the printer to use (if it is not selected).
10. Under Copies group, select the number of copies to print.
11. Click Print.
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3.5 Thumbnail Window
The Thumbnail Window displays a miniature representation of the document pages that allows
easily navigating multi-page documents. Perform the following steps to view thumbnail view of a
document:
1. On the View tab, select Thumbnails check box.
2. The Thumbnail Window will display at the left side of the viewer.

Thumbnail Window

Thumbnail

The pages of the document can be viewed in the document view area of the viewer by scrolling the
bar of the thumbnail window. Click on the thumbnail image (page) and the selected thumbnail will
get open in the right side, that is, in the document viewer area of the viewer. The thumbnail that is
currently viewed in the document view area of the viewer will be highlighted in the different color,
signifying that this page is currently being viewed in the document view area of the viewer.

Currently viewing page
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The sequence of the pages of the document can be changed in the thumbnail window. The most
convenient way to move or copy a page of the document is to select and drag it to the desired
location on the document. The same works here. Just hold the mouse button down over the page,
scroll it through the thumbnail window and release the mouse, drop the page, where the page is to
be copied at or moved to.
3.6 Zooming Text/Image in a Document
Zoom is a feature that either increases or decreases the size of a page or the size of all the text
displayed in a page (Text Zoom) in order to improve readability. You can zoom in to get a close-up
view of the file/document or zoom out to see page at a reduced size. Perform the following steps to
zoom text/image:

1. On the Home tab, click (
2. On the Home tab, click (

) to increase the magnification percentage of the page.
) to decrease the magnification percentage of the page.

Rubber Band Zoom
Another type of zoom that eViewer HTML5 provides is the Rubber Band Zoom that magnifies
the selected image or text area in order to improve the readability of the image or text. Perform the
following steps to perform rubber band zoom on the text or image:
1. On the Home tab, click the Rubber Band Zoom ( ).
2. Select an area on the page. For this, hold down the left mouse button and drag the mouse
pointer diagonally.
3. A box forms between the starting and ending positions of the mouse pointer.
4. Release the left mouse button when the area has been defined.
5. The rubber-banded magnified area will display in the center of the screen.
3.7

Searching Text in a Document

The eViewer provides the text search functionality to enable users to quickly find text information in
a document. Perform the following steps to search text in a document.
1. On the Home tab, type the text to search in Search Text box.
2. Press Enter.
3. If the result is found, the searched text will be highlighted in the document.
4. Click
arrows to go to the previous and next matched text.
5. Select or clear Highlight All checkbox to display all the searched text found in the
document.
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6. Select or clear Match Case checkbox to search only for words that match the case of the
word or phrase that has been typed in the text box. This means that the search becomes
case-sensitive. For example, if you search menu, the result includes all instances of menu
with this exact spelling but not Menu or MENU.
7. Click Advanced Search (
) to search the text with other advanced search options.
8. The Advanced Search dialog box appears.

9. Type the text to search and select the option as per your need.
 Match Case: If selected, searches only for words that match the case of the word or phrase
that has been typed in the text box. This means that the search becomes case-sensitive. For
example, if you search menu, the result includes all instances of menu with this exact
spelling but not Menu or MENU.
 Match whole words only: If selected, restricts the search to whole words only. Whole
words are words separated, on both sides, by a space. For example, if you search for edit,
the result includes instances of edit only not editing, editor, editorial, and edited.
10.
11.
12.
13.

Click Search.
All the matched text will display in the window.
Click on the desired matched text.
The application will bring to the page on which the match was found.
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3.8 Collaborative annotations
There are two collaborative annotations, namely, „Checkpoint‟ and „SideNote‟. Its vivid features are
briefly illustrated underneath.
3.8.1 Check Point
The Check Point annotation is a great tool to assist users in reviewing and verifying forms. Users
open the Check Point pane to quickly jump from area to area, verifying the information according to
the instructions and mark each item as “Approved” or “Rejected”. The user can perform the
following steps to add a checkpoint annotation on any specific area of the document:
1. On the Annotate tab, click Check Point (

) annotation tool.

2. The pointer will change to tick mark.
3. Move the pointer to the place to begin. Click and drag diagonally on the screen and release the
mouse button.
4. The comments dialog box will appear.

5. Type the comments for the checkpoint in the text box and click the Save.
6. The CheckPoint dialog box will pop up from the right hand side with your comments and
two buttons – Accept and Reject.
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7. The reviewer will review the comments and if agree, will „Accept’ the comments, otherwise
„Reject’. Upon Accepting, the status will change from unchecked to Approved and other
requisite information such as Approver‟s name with date and time will appear in the
Information section.
8. On rejecting, the pop up will appear asking the reason of rejection. Type the reason in the
provided text box and click OK.

9. On Rejecting, the status will change from unchecked to Rejected and other requisite
information such as Rejecters name with date and time and the reason of rejecting will
appear in the Information section.
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3.8.2 SideNote
The SideNote annotation enables reviewers to step through each SideNote annotation in the opened
documents or images, review and add additional information and comments regarding an
annotation, along with a complete audit trail of the comments. The user can perform the following
steps to add a SideNote on any specific area of the document:
1. On the Annotate tab, click SideNote (

) annotation tool.

2. Move the pointer to the place where you want the sidenote to begin. Click and drag diagonally
on the screen and release the mouse button.
3. The comments dialog box will appear.

4. Type the title name of the side note in Enter the Title.
5. Type the comments in the comments area.
6. Select the option from the list of available options in both the drop down boxes.
7. Click Save.
8. The SideNote dialog box will pop up from the right hand side with your comments and the
selected options.
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9. Click Add Reply to reply the comments.

3.9 Data Masking
The data masking annotation enables users to temporarily hide sensitive data from others. Users
can easily create data masking elements directly on the document without permanently
modifying the document. Documents can also be exported to PDF and/or printed with the data
masking annotations for easier distribution

Illustration
The user can mask the desired text by executing the following simple steps.
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Step 1: The user has to select the “masking” to initiate the function to mask the desired content.

Step 2: The user will be able to draw with their mouse around the desired area of the document to
mask the data. The end result is shown in the figure below, where solid rectangle (with black color)
is displayed over the written text. The black color in masking is set by default, but there are several
other color options that user can choose, as per their preference and need.
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3.10

E-mailing Documents from eViewer

The email plugin for the eViewer enables users to email documents directly from the viewer. The
plugin directly interfaces with MS Outlook enabling users to send the document as an attachment to
the email‟s recipients whether, it being a fellow employee or a person outside the organization.
The step by step demonstration of email attachment in eViewer is as follows:
Step 1: Click “Upload & View Document” button to upload the desired document in eViewer. The
button is marked by arrow sign in the below placed figure.
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Step 2: Once, the document is uploaded in eViewer; press the „E-mail‟ icon. The „E-mail‟ icon is
marked by arrow sign in below placed figure.

Note: The click at E-mail icon will trigger an alert, asking user to install „E-mail Plug-in‟. You have
to press „OK‟ button and „E-mail host API.exe‟ will start to download in the system. Now, select the
option of „Run as Administrator‟ and the functionality of mail in attachment will get configured at
your PC - to streamline the process.

User Manual
Document Version: 1.0

25

eViewer HTML5 .NET

Step 3: The pop up will appear; select „Mail As Attachment‟. It is highlighted in below placed figure.
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Step 4: The document will get attached to mail and user is all set to send it at desired destination –
by and by putting the recipient email address, subject, and other related information.

Further to add, the eViewer also allows user to upload the “.msg files” and apply the vivid
functionalities listed in the product.
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3.11

Scanning

Enable your users to directly scan from their workstation into the eViewer and save it to your
organization’s repository. The scanning plugin will enable users to scan from any TWAIN-based scanner
from their workstation with exceptional quality.
The step by step demonstration of scan document in eViewer is as follows:
Step 1: Click “Upload & View Document” button to upload the desired document in eViewer. The button
is marked by arrow sign in the below placed figure.

Step 2: Go to scan document within the file menu.
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The Viewer offers multitude of options for document scanning. It comprises of two modes such
as „Duplex‟ and „ADF‟. Further, user can adjust „Resolution‟ and „Color Scale‟ to avail better
clarity and view - in the output produced.

Once, all the fields are correctly filled by user, the user needs to press the „Scan‟ button. The
„Scan‟ button is highlighted with the arrow mark in the above placed figure.
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The scanned document can be subsequently saved and stored for future reference. This
is figuratively illustrated underneath.
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3.12

Multiple Document Rendering

The robust functionality of „Multiple Document Rendering‟ allows the opening of a multiple
documents, and user can seamlessly work on any window to get the desired output. The user can
redact, retrieve, annotate or view document – as the robust document support is provided. The user
can upload multiple documents by placing the respective URL (or absolute path of file) at the field
of „Document URL‟.
Here, it is important to note that the URL of multiple numbers of documents uploaded on eViewer
should be precisely and appropriately separated by semicolon (;). This is shown with the highlighted
area in the below placed figure.

The user can upload as many numbers of files and documents into the eViewer. The each of
uploaded document will get opened into the new window – and user can easily work on to view,
annotate, retrieve or redact the document. The highlighted area in the below placed figure shows
that multiple number of documents are uploaded into the eViewer, and each of them to get opened
into the separate window.
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4. Annotations
Annotations are comments, notes, markups, explanations, or other types of external remarks that
can be added to a selected part of the document to point out, explain or illustrate area or item on the
document.
eViewer provides tools to enable users to freely write their comments, sticky notes and add markups
on documents to help with collaborating with others. Additionally it provides the ability to add
digital stamps, and other markups to make the eViewer an ideal solution for a business workflow
environment.
Annotation marks are saved as annotation data that is stored on a separate file and not on the
original document. Whenever a user makes an annotation, a file with the same name as the
document with an extension .xml is created in the current directory. The annotations can also be
printed with the document if the user chooses.
The following are the available annotations that are provided by the eViewer:
4.1 Line
The Line annotation tool provides the user with the ability to draw a horizontal, vertical, or lines at
45° with the following adjustments: color, thickness, and transparency. The user can perform the
following steps to create a line annotation:
1. On the Annotate tab, click Line (
).
2. Click where the line to begin, and then drag the mouse to the place where it should end, and
release the mouse button.

Edit Properties of Line
1. Select and right click on the annotation.
2. The Line Properties dialog box will appear.

3. To set the color of the line: Select the color from (
) in the Annotations tab.
4. To set the width of the line: Select the width from the Border Width drop down box.
5. To adjust the transparency of the line: Slide the bar to adjust the transparency of the line
from Transparency.
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6. Click OK.
4.2 Rectangle
The rectangle annotation tool draws a rectangle with the following available adjustments: line and fill
color, thickness, and transparency. The user can perform the following steps to create a rectangle
annotation:
1. On the Annotate tab, click Rectangle ( ).
2. Click and drag diagonally on the screen and release the mouse button.
Edit Properties of Rectangle
1. Select and right click on the annotation.
2. The Rectangle Properties dialog box will appear.

3. To set the color of the border of the rectangle: Select the color from (
) in the
Annotations tab.
4. To set the width of the rectangle: Select the width from the Border Width drop down
box.
5. To fill color inside the rectangle: Select the color from the list of colors displayed in the
Background Color.
6. To adjust the transparency of the rectangle: Slide the bar to adjust the transparency of
the rectangle from Transparency.
7. Click OK.
4.3 Circle
The circle annotation tool draws a circle with the following adjustments: line and fill color,
thickness, and transparency. The user can perform the following steps to create a circle annotation:
1. On the Annotate tab, click Circle ( ).
2. Click and drag diagonally on the screen and release the mouse button.
Edit Properties of Circle
1. Select and right click on the annotation.
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2. The Circle Properties dialog box will appear.

3. To set the color of the border of the circle: Select the color from (
) in the
Annotations tab.
4. To set the width of the circle: Select the width from the Border Width drop down box.
5. To fill color inside the circle: Select the color from the list of colors displayed in the
Background Color.
6. To adjust the transparency of the circle: Slide the bar to adjust the transparency of the
circle from Transparency.
7. Click OK.
4.4 Arrow
The arrow annotation tool draws a horizontal, vertical or 45° arrow with the following adjustments:
color, thickness, and transparency. The user can perform the following steps to create an arrow
annotation:
1. On the Annotate tab, click Arrow (
).
2. Click and drag diagonally on the screen and release the mouse button.
Edit Properties of Arrow
1. Select and right click on the annotation.
2. The Arrow Properties dialog box will appear.

3. To set the color of an arrow: Select the color from (
) in the Annotations tab.
4. To set the width of an arrow: Select the width from the Border Width drop down box.
5. To adjust the transparency: Slide the bar to adjust the transparency of an arrow from the
Transparency.
6. Click OK.
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4.5 Highlighter
The highlighter annotation tool provides the user with the ability to provide highlight markups with
the viewer. The user can perform the following steps to create a highlight annotation:
1. On the Annotate tab, click Highlighter (
).
2. Click and drag diagonally on the screen and release the mouse button.
Edit Properties of Highlighter
1. Select and right click on the annotation.
2. The Highlighter Properties dialog box will appear.

3. To fill color inside the highlighter: Select the color from the list of colors displayed in the
Background Color.
4. To adjust the transparency: Slide the bar to adjust the transparency of the highlighter from
the Transparency.
5. Click OK.

4.6 Pen
The pen annotation tool draws freehand lines and shapes with the following available adjustments:
color, thickness, and transparency. The user can perform the following steps to create a freehand
line annotation:
1. On the Annotate tab, click Pen (
).
2. Click on the screen and drag the mouse. The mouse will follow your moves. Release the
mouse button to end your drawing.
Edit Properties of Pen
1. Select and right click on the annotation.
2. The Pen Properties dialog box will appear.
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3. To set the color of the freehand line: Select the color from (
) in the Annotations tab.
4. To set the width of the freehand line: Select the desired width from the Border Width
drop down box.
5. To adjust the transparency: Slide the bar to adjust the transparency of the freehand line
from the Transparency.
6. Click OK.

4.7 Text
The text annotation tool enters text on a page with the following available adjustments: size and
color of the font and the text box. The user can perform the following steps to create and place any
text annotation:
1.
2.
3.
4.
5.
6.
7.

On the Annotate tab, click Text (
).
Click and drag diagonally on the screen and release the mouse button.
Double click on the text box to type text in the box.
A cursor will appear on the screen allowing you to type in text.
To finish editing text, click anywhere outside the text box.
To edit the text later, double click on the text.
The text box can be repositioned by dragging the text box border and the size of the text
box can be adjusted by dragging the selection handles.

Edit Properties of Text
1. Select and right click on the annotation.
2. The Text Properties dialog box will appear.
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3. To set the border color of the text box: Select the color from (
) in the Annotations
tab.
4. To set the width of the text box: Select the width from the Border Width drop down box.
5. To fill color inside the text box: Select the color from the list of colors displayed in the
Background Color.
6. To adjust the transparency: Slide the bar to adjust the transparency of the box from the
Transparency.
7. To set the color of the text: Select the color from the list of colors displayed in the Text
Color.
8. To set the font size of the text: Select the size from Text Font-Size drop down box.
9. To set the font family of the text: Select the font family from Text Font Face drop down
box.
10. Click OK.
4.8 Stamp
This tool allows adding wide variety of readymade or custom made stamps on the document. You
can place images and/or text stamps anywhere on the document. The user can choose either from a
list of predefined stamps or create their own stamps. The user can perform the following steps to
create and place a stamp annotation on the document:
1. On the Annotate tab, click Stamp (
).
2. The Stamp Properties dialog box appears.

User Manual
Document Version: 1.0

37

eViewer HTML5 .NET

3. Click New Stamp to create new stamp, else use the existing ones.
4. The New Stamp dialog box appears.

5. For the new stamp, select the border and text color, thickness and transparency in the
Background-Color, Text-Color, Border-Width and Transparency respectively.
6. Under Text, type the name of the stamp in the text box. Click OK.
7. The newly created stamp has been created and will be listed in the list box.
8. Click OK.
Edit Properties of Stamp
1. Select and right click on the stamp.
2. The Stamp Text dialog box will appear.
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3. To set the border color of the stamp: Select the color from (
) in the Annotations
tab.
4. To set the width of the stamp: Select the width from the Border Width drop down box.
5. To fill color inside the stamp: Select the color from the list of colors displayed in the
Background Color.
6. To adjust the transparency: Slide the bar to adjust the transparency of the stamp from the
Transparency.
7. To set the text color of the stamp: Select the color from the list of colors displayed in the
Text Color.
8. To set the font size of the text of the stamp: Select the size from the Text Font-Size
drop down box.
9. To set the font family of the stamp: Select the font family from the Text Font-Face drop
down box.
10. Click OK.
Delete the Stamp
Perform the following steps to delete any existing or predefined stamps:

1.
2.
3.
4.

Click
.
The Stamp dialog box will appear.
Select the stamp to delete from the list of available stamps.
Click Delete.

 You cannot delete all the stamps. There must be at least one stamp available in the list.
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4.9 Strikeout and Highlighter
eViewer provides two commenting tools, strike out and highlight, designed for different
commenting tasks. Most comments include two parts: the markup or icon that appears on the page,
and a text message that appears in a pop-up note when you select the comment.
Strikeout: The ability to cross out words. After you use this feature, the word remains, but a line is
drawn horizontally through the midsection of the letters. Perform the following steps to strike out
text in a document:
1. On the Annotate tab, click Strikeout/Highlight (
).
2. Select the text to display with strikeout marks. To do this, place your cursor at the beginning
of the text, hold down the left mouse button, drag the mouse across the word or sentence
and then release the mouse button.
3. The dialog box will appear.

4. Type the comments in the comments text box area.
5. Click ( ) to change the color of the comment area. The color palette will appear. Select the
color from the list of available colors.
6. Select the tag for comments – correction, suggestion, fixed or important.
o To provide the new tag to the comment, click ‘New tag’ text box.

o Clicking the box will bring the text box in an editable mode.
o Provide the new tag name.
o Click .
o The new tag has been added in the tag list.
7. Click Save.
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8. The comment is displayed at the right hand side of the viewer within the comment box.

9.
10.
11.
12.

Click Edit to re-edit the comment.
Click Reply to reply with your valuable feedback on the existing or reviewed comments.
Click Delete to delete the comment.
Click ( ) to minimize the comment box.

13. The (

14. Click (

) icon is displayed at the strike out text.

) to read the strikeout comment.

Highlight text: The user can perform the following steps to highlight text in a document.
1. Select the text to display with the highlighted color. To do this, place the cursor at the
beginning of the word, hold down your left mouse button, drag the mouse across the word
or sentence and then release the mouse button.
2. The box will appear.
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3. Click ( ).
4. The pop up window will appear.

5. Click Highlight and select the color from the list of available colors to highlight text with
the selected color.
 If you do not select color, the text will be highlighted with the default selected color.

6. Provide the comments in the comment area.
7. Click ( ) to change the color of comment area. The color palette will appear. Select the
required color from the list of available colors.
8. Select the tag for the comments – correction, suggestion, fixed or important.
 To provide new tag to the comments, click New tag text box.

 Clicking the box will bring the text box in an editable mode.
 Type the new tag name.
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 Click
.
 The new tag has been added in the tag list.
9. Click Save.
10. The comment has been highlighted in the page and is displayed in the right hand side of the
viewer within a comment box.

11.
12.
13.
14.

Click Edit to re-edit the comment.
Click Reply to reply with your valuable feedback on the reviewed comments.
Click Delete to delete comment.
Click ( ) to minimize comment box.

15. The (
16. Click (

4.10

) icon is displayed at the highlighted text.
) to read the comment of the highlighted text.

Cloud

The cloud annotation tool draws cloud with a series of connected lines with adjustments: color and
thickness. The user can perform the following steps to draw the cloud annotation:
17. On the Annotate tab, click Cloud ( ).
18. Move the pointer to the place to begin, and then drag the mouse to the place where it should
end, and release the mouse button.
Edit Properties of Cloud
19. Select and right click on the annotation.
20. The Cloud Properties dialog box will appear.
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21. To set the color of the Cloud: Select the color from the Color group in the Annotations
tab.
22. To set the width of the Cloud: Select the width from the Border Width drop down box.
23. To adjust the transparency: Slide the bar to adjust the transparency of the cloud from the
Transparency.
24. Click OK.

5. Adding Watermarks
Watermarks are text or pictures that appear behind document text. They often add interest or
identify the document status, such as marking a document as a Draft, Confidential, and Urgent.
eViewer provides a list of standard watermarks, or the user can create their own custom watermark,
such as company logo. The user can perform the following steps to create a watermark:
1. On the Annotate tab, click Add Watermark (
2. The Watermark dialog box will appear.

).

3. Provide the details of the watermark corresponding to each field.
4. Click OK.
5. The watermark will be added on each page of the document.
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6. Bookmarking Pages in a Document
A user working with a large document needs to return to a specific location in the document for any
purpose, Bookmark feature can prove invaluable. Rather than having to scroll through the pages of
the document, user can quickly jump to the marked page with this feature. The user can perform the
following steps to add bookmark:
1. Go to the Thumbnail Window that lists all the pages of the document. If it is not open, go
to the View tab, select Thumbnail check box.
2. Hover mouse on the desired pages to place bookmark.
3. The blue color icon ( ) will display at the top left corner of the page.
4. Click ( ).
5. The selected page has been bookmarked successfully.
6. Repeat the above steps to add multiple bookmarks in the document.
Edit/remove bookmark pages:
Bookmarks can be edited/removed by one of the following ways:



Menu option
Thumbnail Window option

Through Menu Option:
1. On the Annotate tab, click Add Bookmark ( ).
2. The Edit Bookmark dialog box listing bookmarked and unbook marked pages of the
document will appear.

 The icon (

) corresponding to the pages are bookmark pages.
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3. To remove bookmark from any specific page, click (

) icon corresponding to that page.

4. The ( ) icon will become ( ) signifies that bookmark has been removed successfully from
the selected page.
5. To add bookmark on the page, click ( ) icon corresponding to the page. The ( ) icon will
become ( ) signifies that bookmark has been added successfully on the selected page.
6. Click Update.

Through Thumbnail Window:
1. Go to the Thumbnail Window that lists all the pages of the document. If it is not open, go
to the View tab, select Thumbnail checkbox.
2. The pages marked with blue color icon ( ) are bookmark pages(s).
3. To remove bookmark from the page, click ( ) icon corresponding to that page.
4. The icon will disappear from the selected page signifies that the bookmark has been
removed successfully from the page.

7. Advance Redaction
Several type of confidential information comes in the form of text patterns (Social Security
Numbers, Account Numbers, Date of Births, Passport Numbers, and Names) that needs to be
removed from the documents. eViewer provides a text pattern search capability that allows fast and
easy identification of predefined text patterns in the documents and files. The Smart Redaction™
provides numerous powerful predefined text search pattern options to automatically find and
highlight the matching searches and then redact them.
Smart Redaction works on all file formats supported by the eViewer including: Word, Excel, PDF,
and TIFF. Redacted files can be published in any formats including PDF, TIFF, and any other
image format. In the published file, anything redacted is permanently removed and cannot be found
in a search and can't be copied.
Perform the following steps to redact any specific text pattern in the document:
1. On the Redact tab, lick (
) and drag over the text.
2. The solid rectangle will display over the redacted text.
There is an advance PDF redaction with the customization of eViewer – by and by implementing
custom GUI elements and custom tools, to keep the user at ease.
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